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PHOTOSHOP FOR 
IPAD IS HERE  

Find out what’s 
in store with this 
mobile Photoshop

CONTENT-AWARE 
FILL EXPLAINED

Learn how to 
sample and fill areas 
with ultimate control

LIGHTROOM 
SKILLS

Discover how to 
watermark your 
prized photos

GOOD 
VIBRATIONS

Learn how to 
shoot and edit 
vibrant paint photos

WATERCOLOR 
PORTRAIT EFFECTS

Blend paint photos 
with your portraits 
for amazing results

Each year we’re treated to a major Photoshop update 
around the fall – and this year doesn’t disappoint. In 
particular, I’m thrilled about the new Object Selection 
Tool and the improved Warp command, which blows 
away the old version. In fact, I’d say CC 2020 is a 
knockout. Discover its highlights this issue. 
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 Welcome to issue 105 of Practical Photoshop! 
If you enjoy the issue, why not subscribe and get 
a whole year for just $19.99?  http://bit.ly/practweet

http://bit.ly/pracface

FIND US HERE…

http://tiny.cc/4dw9ky

http://tiny.cc/rew9ky

http://tiny.cc/8ew9ky

DOWNLOAD THE 
PROJECT FILES
To download this 
issue's files, type 
the following link 

into your web 
browser on your 

PC or Mac:
http://bit.ly/pho_105

WATCH THE VIDEO
http://tiny.cc/h9bbjy



After announcing its 
development a year 

ago, Adobe has now made 
Photoshop for the iPad 
available to Creative Cloud 
subscribers. The tablet version 
of your favorite image-editor 

offers a more accessible 
introduction to Photoshop 
for new users, and works 
as a complementary mobile 
companion for more advanced 
users. This first release focuses 
on compositing and retouching 

workflows, like selections, 
masking, painting, Blending 
Modes and Adjustment Layers. 
With each subsequent release, 
more Photoshop capabilities 
will be added. Here are the 
key features...

NEWS
PHOTOSHOP FOR IPAD IS OUT!
The new app supports PSDs and layers, and offers 
a host of familiar compositing and retouching tools



FULL PSD COMPATIBILITY
Open and edit existing 
Photoshop documents or 
create new ones with 1:1 pixel 
match and data compatibility.
 
FAMILIAR WORKSPACE
Create all the layers you can 
imagine, in both simplified and 
detailed Layers Panels. Core 
tools are all available in the 
Photoshop for iPad toolbar.

COMPOSITING TOOLS
Creatively transform your 
designs, place images onto 
the canvas as layers, and use 
masks and brushes to make 
sophisticated selections – 
either using your fingers 
or with the Apple Pencil.

EDITING AND RETOUCHING TOOLS
Make image adjustments like 
brightness, contrast, hue, and 
saturation, and use levels to 
edit with added control. Adjust 
specific elements with Layer 
Masks. Perfect your images 
with Blending Modes as well 
as the Clone Stamp, the Spot 
Healing Brush, and Crop tools. 
Use gradients, black-and-
white controls, and tools like 
the Paint Bucket, Eyedropper, 
and Color Picker to experiment 
with color. Plus, access curated 
Photoshop brushes.

POWER AND PERFORMANCE
Photoshop on the iPad lets 
you work on large files and 

hundreds of layers without 
performance compromise. 
You’ll find core retouching 
and compositing tools in 
an interface optimized for 
touch and for use with the 
Apple Pencil.

MODERN USER INTERFACE
Photoshop on the iPad offers 
a modern experience in a 
touch-based environment. 
Tool options display as you 
need them, maximizing your 
working canvas.

WORK ANYWHERE
Access your cloud documents 
straight from the Photoshop 
home screen, whether you’re 
on your computer or your 
iPad. Work on the same image 
on iPad or desktop without 
importing. Instead of importing 
or converting your PSDs, just 

connect to the internet and 
pick up where you left off.

YOUR WORK IS SAFE
Photoshop automatically saves 
your content and stores it in 
the cloud. Whether or not you 
continue to subscribe to Adobe 
services, you will have access 
to your files.

DESIGN WHEN YOU’RE OFFLINE
Work on cloud documents –
even if you’re not connected to 
the network – with automatic 
syncing when you’re online.

PART OF CREATIVE CLOUD STORAGE
From synced files to assets 
in Creative Cloud Libraries, 
cloud documents are part of 
the services included with 
your membership and make 
use of your Creative Cloud 
storage allocation.



 DOWNLOAD THE PROJECT FILES HERE http://bit.ly/pho_105 ON YOUR PC OR MAC 

Get to grips with all the new features in our in-depth guide

PS 2020
Every year, Adobe releases a 
new version of Photoshop with 

a raft of new features, as well as subtle 
improvements to functions, workflow and 
performance. Of course, there are also 
updates throughout the year that come as 
part of a Creative Cloud subscription. But the 
annual release is something to look forward 

to, as Adobe often introduces several new 
commands or tools at once.

The new Photoshop CC 2020 out now. 
It comes with an impressive list of new 
tools and enhanced features. Top of the list 
are the Object Selection Tool and improved 
Warp Transform, but there are also plenty 
of others worth looking at...



Like the similarly excellent Select 
Subject command, Object Selection 

employs AI to select the subject, with barely 
any effort on your part. It’s found in the 
toolbar alongside the Quick Selection and 
Magic Wand tools.

Simply drag a loose rectangular box 
(or freehand lasso) over an object that you 
want to isolate within the image, and the 
tool does the rest. It’s especially useful 
when a frame has several subjects – like 

a group photo – as you can target and quickly 
separate individuals from the group. Here 
it lets us target one elephant (while using 
Select Subject isolates both).

Of course, the tool occasionally picks 
up unwanted detail or doesn’t include 
the entire object, but you can refine the 
selection area by holding Alt and dragging 
smaller boxes over parts of the selection 
edge that aren’t quite right. It’s a handy 
additional feature to an excellent tool.

1 OBJECT SELECTION TOOL

WATCH THE VIDEO
http://bit.ly/37nx3rt

This game-changing selection tool uses machine learning 
to snap onto all kinds of objects in no time at all



The Properties Panel has 
been improved to include 

Quick Actions. These handy 
buttons are context-sensitive, 
so for a text layer you’ll see 
options like Convert To Shape. 

One of the most interesting 
is Remove Background: it’s 
available when a pixel layer 
is highlighted. (If it’s the 
Background layer, double-click 
it to make it editable first.) 

The Remove Background Quick Action works by first using 
the Select Subject command, then adding a Layer Mask to 

hide the unselected areas. It’s a clever new feature that will save 
you time, but how well does it perform? We put it through its paces 
with a variety of subjects, awarding marks out of 10 for each…

Remove Background has picked up 
unwanted figures around the edges of 
the car, and it’s understandably struggled 
where the car meets the grass. But it’s a 
timesaving starting point for further edits 
to the mask.

2 QUICK ACTIONS

HOW GOOD IS REMOVE BACKGROUND?

These handy buttons appear in the Properties Panel, and 
vary depending on the type of layer that’s selected

 6/10

BEFORE



The command 
has performed 
surprisingly poorly 
on this one. With 
the bird against a 
uniform, out-of-
focus backdrop, 
you’d think it 
would be a cinch, 
but it has failed 
to include a large 
portion of the 
bird’s body. Of 
course, it’s easily 
fixed afterwards.

 7/10

This is a tricky 
one. Although 
the command has 
failed to include all 
of the struts in the 
wheel, it’s given us 
a useful starting 
point by selecting 
the edges of the 
object. We can 
go on to use the 
Object Selection 
Tool within the 
Select And Mask 
command to 
improve things.

4/10

BEFORE

BEFORE



Remove Background has done a top job 
here: there’s barely a trace of the backdrop 
left, and the bird has been successfully 
cut out. From here, we just need to make 
a quick diversion into Select And Mask 
to improve the fine details between the 
feathers, and then we’re done.

 9/10
A complex selection in a matter of seconds. 
This is where the command usually 
excels: when the subject is against a plain, 
uncluttered backdrop that contrasts with 
the colors in the subject. We’d still use 
Select And Mask to improve the edge 
around the hair, but it’s an easy fix.

10/10

BEFORE



The Warp Transform command has 
long been one of the most useful 

methods for reshaping a layer – and now it’s 
even more powerful.

Previously, the feature separated a layer 
into a grid of nine boxes, each of which could 
be moved to warp the shape. Now you can 
choose any number of boxes for your grid, as 
well as plotting Bézier curves to change the 
look of the shape. The command has the feel 
of the Puppet Warp and Liquify commands, 
and is arguably better than either.

3 ENHANCED WARP TOOLS

BEFORE
AFTER

The Warp Transform controls have been vastly 
improved with a host of new controls...

WATCH THE VIDEO
http://bit.ly/330pjwh



1 
 If you need to go back you can use the Cmd/
Ctrl+Z undo shortcut to cycle back through 

the warp edits, or click the Reset button.

2  
Choosing Custom in the grid dropdown 

gives you the option to set any number of 
horizontal and vertical sections up to 50.

3 
Drag on the lines to move this portion 
of the image, or drag the handle that 

sprouts out from the anchor point.

4 
Once several anchor points are highlighted, 

drag outwards from one side to scale in 
one direction (squashing or stretching the 
image) or drag the corner point to scale in 

all directions.

5 
The Split controls in the options bar give you 
three options for dividing up the warp grid: 

crosswise, horizontally or vertically.

6  
Hold Alt and click on the image to add an 

anchor point. Drag the anchor point to 
warp that area of the image.

7 
Shift-click to select multiple anchor points 
to edit them all at once, or hold Shift and 
drag to form a box over several points to 

highlight them.

8 
Select a point or multiple points and press 
the Delete key to remove them, or use the 
Reset icon in the options bar at the top to 

achieve the same goal.

QUICK TIPS FOR USING THE NEW WARP TRANSFORM



4 THE IMPROVED PROPERTIES PANEL

PROPERTIES PANEL:  
NO LAYER SELECTED

The Properties Panel  offers context-sensitive settings and swift access 
to popular features, depending on the type of layer that is selected...

1  Click the empty grey space in 
the Layers Panel to see these 
options (You may need to 
increase the panel height first)

2  Change the Canvas properties 
to make the working document 
area larger or smaller

3  Quickly alter the color space 
and bit depth of the image

4  Add a fill layer to the background 
of the document using a color of 
your choice

5  Add guides and rulers to help 
you align and organize parts of 
a design

6  Quick Actions allow you to 
swiftly change the image size, 
make a crop, trim the image or 
rotate the frame

1

2

3

4

5

6



PROPERTIES PANEL: 
PIXEL LAYER SELECTED
1  Transform the pixel layer 

to make it larger or smaller

2  Quickly change the rotation 
and angle of the layer

3  Flip the layer horizontally or 
vertically with these two icons

4  Align layers in different ways 
(only available when multiple 
layers are highlighted)

5  Select the subject or Remove 
the background using these 
Quick Action buttons

1

3

5

2

4



PROPERTIES PANEL: 
TEXT LAYER SELECTED
1  Transform the X/Y coordinates 

of the type, or rotate, flip or 
enlarge it

2  Choose a font (all 17,000 Adobe 
fonts are now included with a 
Creative Cloud subscription)

3  Quick access to the main 
character options - sizing, 
leading, kerning and tracking

4  Useful type formatting and 
style options like All Caps 
and Underline

5  Quickly convert text to a frame, 
or go from text to shape

1

3

5

2

4



Photoshop CC 2019 saw a change to 
the way layers were resized: it as no 

longer necessary to hold the Shift key to 
constrain the proportions - from now on the 
default would be to keep proportions, and 
the Shift key would allow you to squash or 
stretch while resizing instead. Only it wasn’t 

consistent: Smart Objects still required the 
Shift key. Now things have changed slightly, 
and the Constrain Proportions feature can 
be turned on or off in the Transform options. 
It’s a welcome tweak for those of us who 
can’t quite shake the muscle memory of 
Shift-dragging to resize.

5 FREE TRANSFORM
Adobe fixes the free transform control for consistency across all layer types



Gradients, Shapes and Patterns now 
have their own dedicated panels for 

accessing presets. Previously, the settings 
for each were tucked away in tool options, 
but now they are easier to manage and can 
be fitted into your Photoshop interface 

for quick access. It makes it much easier 
to create groups for your favorite presets, 
largely doing away with the rather clunky 
Preset Manager. The Swatches and Styles 
Panels have also been improved to align 
with this new workflow.

6 NEW AND IMPROVED PRESET PANELS
Preset Panels for Gradients, Shapes and Patterns make 

these features easier to access and organize



When you merge several images 
into a panorama with Camera Raw’s 

Merge command (or with Lightroom), you’ll 
often find the edges of the panorama has 
transparent gaps.

As well as the existing Boundary Warp 
feature, there is now another option to 
fill the empty areas using Content-Aware, 
which generates new pixels based on the 
content of the image.

7 FILL PANORAMA EDGES
Quickly fill in inevitable messy transparent edges when you merge a panorama



8 EXPAND SMART OBJECTS

9 HIDDEN GEMS AND HANDY TWEAKS

Quickly expand a Smart Object to 
access all the layers within it, using 

this handy button

Each major update comes with a host of little improvements – 
here are some of our favorites so far...

A new button in the Properties Panel 
lets you expand a Smart Object to 

reveal all the separate layers contained 
within the Smart Object layer. You can either 
click Convert To Layers in the Properties 
Panel (with the Smart Object layer 
highlighted), or go to Layers > Smart Objects 
> Convert To Layers.  The expanded layers 
will be placed in a new Group.

1   Alt-click a layer in the Layers Panel: the 
view will zoom to fit the contents of that 
layer on-screen

2  You can now add Gradients to Libraries, 
to save and share them with others

3  When you use the Brush Tool, you can 
now rotate the brush tip one way or 
another using the left and right arrow 
keys on your keyboard

4  When you press Cmd/Ctrl+N to make 
a new document, the dialog box loads 
much quicker than before

5  The Lens Blur filter now supports HEIC 
image files with embedded depth maps 
(like those taken  with a smartphone with 
two lenses), so you can control the amount 
of blur with the filter

6  The Content-Aware Fill command now let 
you choose from three different sampling 
options – Auto, Custom and Rectangular – 
that let you fine-tune what is sampled to 
create the fill

7  Press and hold the tilde key (~) to 
temporarily switch to erasing while 
you’re using the Brush Tool



The Content-Aware 
Fill command works 

by rebuilding parts of 
your image, helping you 
remove unwanted objects, 
improve messy details or 
tidy up a composition. The 
feature has been a part of 
Photoshop for some time, 
but was recently given a 
welcome update, making it 
much more controllable. 

Previously you would 
make a selection, then 
use Content-Aware Fill: 

This updated command offers greater control than 
ever while you’re removing unwanted details

HOW TO MASTER THE 
CONTENT-AWARE FILL TOOL 

 DOWNLOAD THE PROJECT FILES HERE http://bit.ly/pho_105 ON YOUR PC OR MAC 

WATCH THE VIDEO
http://bit.ly/2kbpqpv

AFTERBEFORE

from the lizard’s body, the 
tree and elsewhere. 

This is where the 
new Content-Aware Fill 
command comes in. You can 
be very specific about which 
parts of the photo you want 
the command to sample 
from, so you can exclude the 
foreground details and force 
it to use the blurry backdrop 
instead. You can also fine-
tune the way it samples 
and reuses pixels. Let’s 
take a closer look...

Photoshop would determine 
what to remove by analyzing 
the rest of the frame and 
generating new pixels based 
on the content of the image.

The problem is, it 
occasionally samples and 
uses parts that you don’t 
want to replicate. Here, for 
example, I want to remove 
the distracting leaf next 
to the lizard’s head. But a 
straightforward fill results 
in a mess of pixels, as the 
command samples details 



1

THE SAMPLING BRUSH
You can paint over the image 
with the Sampling Brush to 

subtract parts of the sample 
area, or hold down Alt and 
paint to add them. Use the 

] and [ keys to resize the 
brush tip while you work. 
As you paint, the preview 

shows how different 
sample areas affect the 

results. Here our initial fill 
has replicated unwanted 

details in the lizard and 
tree, so we’ve removed 
the foreground details 

from the overlay. 

2

MAKING A SELECTION
Before you begin using 

Content-Aware Fill, you need 
to make an initial selection 

over the area or object 
you want to fill in. A loose, 

freehand selection with 
the Lasso Tool will often 
do the job perfectly well. 
Now you can go to Edit > 

Content-Aware Fill. There’s 
another Lasso tool within 
the command if you need 

to add or subtract from the 
initial selection; you can also 
use the Expand and Contract 

buttons to alter its edge.

3

THE WORKSPACE
The dialog box shows a 
split-screen view, with 

the original image on the 
left and a preview of the 
resulting fill on the right. 
The dividing line can be 

dragged either way to give 
either window more room. 

Hand and Zoom tools let you 
zoom in and move around 

the image, but you can also 
press Ctrl/Cmd plus the – or 
+ keys to zoom in and out. 
Fit and Fill Screen buttons 

let you quickly jump to 
different zoom levels.

1
2

3



4

THE OVERLAY
The overlay shows which 

parts of the original image 
are being targeted to 

generate the fill. You might 
find that there’s no need 
to alter the sample area. 

But if, like here, the initial 
fill looks wrong, you can 

exclude parts of the frame 
so that the command homes 

in on the areas you want 
to replicate. The overlay 
is green by default, but 
you can choose another 

color, and choose whether 
it indicates the sampling 

area or the excluded area. 

5

SCALE AND MIRROR
Scale is useful to deploy 

when the Content-Aware Fill 
command is remaking details 

or repeating patterns that 
are different sizes, or if the 
sample area is at a different 

perspective to the fill 
area. Enabling Mirror allows 
for the sampled content to 
be flipped if necessary for 

a better fill, so it’s helpful in 
symmetrical objects, where 

you can target one half 
to help fill in unwanted 

details on the other half. 
Neither option is necessary 

for our image here.

6

COLOR AND ROTATION 
ADAPTATION

These two settings affect 
the way Photoshop 

generates the fill. Color 
Adaptation allows contrast 

and brightness to vary 
across the fill. It’s useful 

if there are graduated 
colors in the working area. 
Choosing Very High gives 
us a smoother result here. 

Rotation Adaptation means 
the tool rotates sampled 
areas: it’s good for details 
where the part you want 
to target is at a different 

angle to the fill area.

4

5
6



You can have lots 
of fun with filters, 

Blending Modes and brushes 
in Photoshop – and the great 
thing is, they’re easy to use. 
A vibrant portrait effect like 
this might look complicated 
to do, but it’s actually pretty 
simple to pull off. In this 
project we’ll explain how. 
We’ve supplied a starting 
image, although it’s more 
fun to use your own – any 
portrait will do, but it helps 
if the subject is against a 
clear, bright backdrop.

James Paterson shows you how to create this fun effect 
and demonstrates a host of key Photoshop editing skills

SPLASH PAINT PORTRAITS

 DOWNLOAD THE PROJECT FILES HERE http://bit.ly/pho_105 ON YOUR PC OR MAC 

WATCH THE VIDEO
http://bit.ly/35ferpp

AFTER

To add splashes of color 
to our portrait, we’ve used a 
separate image of paints (go 
to www.pixabay.com and 
search for ‘2681039’). This 
is blended using the Screen 
Blending Mode, which 
creates a double-exposure 
effect by combining the 
lightest parts of two photos. 

Next, we use a set of 
brushes to add splashes 
and spatters. These Adobe 
brushes are free – there’s a 
link within Photoshop, in the 
Brushes Panel.

BEFORE

Aside from learning this 
effect, we’ll uncover useful 
Photoshop features like 
Smart Objects. These are 
key to a non-destructive 
workflow, as they allow 
you to keep filter effects 
editable. You can go back 
and tweak settings or try 
a new effect at any stage 
in your workflow. We’ve 
used the Torn Edges filter 
to transform our photo into 
blocky black-and-white 
tones. Once done, we can 
add our paint effects. 



02  COPY AND MASK
Continue painting 

the skin to remove marks, 
using the ] and [ keys to 
resize your brush, and 
holding Cmd/Ctrl+Space 
while dragging to zoom 
in or out while you work. 
When you’ve finished 
doing this, press Cmd/
Ctrl+Shift+Alt+E to merge 
a new layer, then go to 
Image > Adjustments > 
Invert to invert the tones.

03 MAKE A SKETCH 
Duplicate the layer, 

right-click the mask and 
choose Delete Layer 
Mask, then double-click 
Filter Gallery. This time go 
to Sketch > Photocopy 
and set Detail 9, Darkness 
1. Click OK, then go to the 
Layers Panel and change 
the Blending Mode to 
Multiply. This gives us a 
subtle sketch effect. Now 
highlight the layer below.

01   APPLY A FILTER
Open the portrait in 

Photoshop and duplicate 
the Background layer with 
Cmd/Ctrl+J. Right-click 
the copy in the Layers 
Panel and choose Convert 
to Smart Object. Press D 
to reset colors, then go 
to Filter > Filter Gallery. 
Go to Sketch > Torn 
Edges and set Balance 
32, Smoothness 13, 
Contrast 15, then click OK.



05  LOAD PAINT 
BRUSHES

Next, we’ll make paint 
extra splashes. Go to the 
Brush Panel (Window > 
Brushes), click the menu 
icon and choose Get More 
Brushes. This takes you 
to an Adobe web page. 
Download the Scatter and 
Watercolor sets. Right-
click the resulting ABR file 
and choose Open With 
Photoshop CC to load them.

06 ADD SPLASHES 
Click the New Layer 

icon in the Layers Panel 
then grab the Brush Tool, 
set the foreground color 
to white and choose a 
scatter brush. Dab over 
the image to rough up 
the edges of the subject. 
Continue painting, using 
other brushes and colors 
if you like, to build up the 
colors and the scattered 
paint effect.

04   BLEND THE PAINT
Open a photo of 

watercolor paint (you can 
download one from www.
pixabay.com). Grab the 
Move Tool and drag the 
watercolor paint image 
into the portrait image. 
Change the Blending Mode 
to Screen, then press 
Cmd/Ctrl+T and use the 
bounding box to resize 
or rotate the image to fit 
over the portrait.



Sometimes joy comes 
from creating a great 

image. Other times, the end 
result is more of an added 
bonus, and instead it’s the 
process behind the image 
that’s the most joyous part. 
This project definitely falls 
into the latter category… 
It can result in wonderfully 
vibrant photos, but the 
technique itself is just 
as compelling.

 That’s because in this 
project, you get to make 
paint dance! You get this 

effect by placing drops of 
paint on top of a speaker, 
then playing a song at high 
volume. As the speaker kicks 
out air, the paint jumps to 
the beat. There’s something 
hugely appealing about the 
idea of capturing music in 
this visual way. 

The speaker is simply 
a means of creating 
vibrations, so the music 
is somewhat secondary, 
but you will get variations 
between different songs 
depending on the rhythm. 

So the choice of music gives 
character to the shot, and 
you’ll get different patterns 
and motions from the sound 
of Beethoven, James Brown, 
or Daft Punk.

It happens very quickly, 
so you need to get set up to 
capture high-speed action. 
This involves a flashgun. 
Shooting in a darkened 
room, you use the flashgun 
to freeze the motion of 
the paint. This way, the 
flash duration effectively 
becomes the shutter speed.

James Paterson uses loudspeakers and music 
to create lively photos of dancing paint

GOOD VIBRATIONS

 DOWNLOAD THE PROJECT FILES HERE http://bit.ly/pho_105 ON YOUR PC OR MAC 

WATCH THE VIDEO
http://bit.ly/2o2vqxd



THE SET UP HOW TO MAKE PAINT DANCE

1 SPEAKER
You need a fairly powerful 

speaker with plenty of bass 
to make your paint jump 
into the air. We used the 

subwoofer from a TV sound 
system, placed on its side 

and connected to our phone 
via Bluetooth. We placed 

our camera on a tripod 
opposite the speaker.

4 CLOSE-UP LENS
We used a macro lens for 
this, but you don’t really 

need one. Our paints 
covered an area about 

15cm across, which is not 
necessarily macro territory. 
Any long lens that lets you 

shoot close-up will do. A low 
camera angle will emphasize 

the height of the paint.

2 CLING FILM
The drops of paint are 
carefully placed onto a 

piece of taut cling film that’s 
stretched over the speaker. 

After a few seconds of 
frantic jumping the colors 

will mix together, creating a 
muddy green. So you need 

to refresh the paint and cling 
film after every few shots.

5 DARK ROOM
You need to keep ambient 

light to a minimum: the 
brighter the room is, the 

greater the chance of blur. 
By removing ambient light to 
darkness, you can ensure it 
plays a minimal part in your 
exposure, which allows you 
to use a fast flash duration 

and freeze the action.

3 BLACK BACKDROP
The black side of a reflector 
acts as a dark backdrop for 

our scene. It’s placed far 
enough away so that the 
flash doesn’t spill onto it. 

The paint can cause quite a 
mess, so it’s a good idea to 
protect floors and surfaces 
by covering them up. Wear 

some old clothes too.

6 LIGHTING
A single flashgun is placed 

on a stand to the left of the 
paints, with a silver reflector 

held opposite to bounce 
some of the light back into 
the shadows. The flashgun 

is set to manual with output 
at 1/32 power. It is fired 
wirelessly with a trigger 

and receiver.

Behind the scenes on our trick balancing-act portrait



01  SHOOT IN 
MANUAL MODE

Our DSLR camera is in Manual 
mode with the following 
settings: shutter speed 
1/200 sec, aperture f/32, ISO 
1,000. The narrow aperture 
means that we get a wider 
plane of focus with a greater 
depth of field, which is 
especially useful here, as we 
can’t be sure exactly where 
the paint will bounce up.

02  PRE-FOCUS 
ON A SPOT

Precise focusing is critical 
to close-up photography, 
but it’s impossible to focus 
while the paint is moving, 
so you need to pre-focus 
beforehand on the most 
likely spot. Set the lens to 
manual focus and use Live 
View to focus on the center 
of the motionless paint lying 
on the cling film.

03  USE A LOW 
FLASH POWER

A lower flash power setting 
will give you a shorter flash 
duration. At full power, our 
Yongnuo 560 IV flashgun 
has a flash duration around 
1/300 sec, but at 1/32 
power this jumps to a more 
effective 1/7,000 sec 
(approx). So for faster flash 
durations, lower the power 
of the flashgun.

 SHOOT THE ACTION IN AN INSTANT



04  MIX THE PAINTS
We used a combination 

of water-based paints 
for our photo shoot. The 
thickness of the paint is 
important: if it won’t bounce 
it’s too viscous. However, 
if it’s too thin, it’s likely to 
spray around everywhere! 
Experiment by mixing the 
paint with water until you 
find the right thickness to 
get great results.

05  CRANK UP 
THAT BASS

Part of the fun of this 
project is in finding out how 
different music affects the 
motion of the paint. A tune 
with a fast rhythm can work 
well. Whatever music you 
choose, crank up the bass 
setting on your speaker to 
its maximum: it makes a 
huge difference to the power 
of the bouncing beat.

06  TIMING THE SHOT
Your timing is crucial. 

It can be difficult as you start 
shooting to predict the best 
moment to press the shutter, 
so after turning the music 
on, fire off a series of frames 
as quickly as your flash will 
allow. After a short while 
the paints will mix together, 
so you’ll need to refresh the 
paint and cling film to try 
some more shots.

THE SHOT LIST 



01  TIDY THE BACKDROP
Opening your favorite 

shots in Photoshop, enhance 
the colors and add punch by 
boosting the saturation and 
contrast. If there are any 
unwanted reflections on the 
cling film, grab the Brush Tool 
and paint black over them. 
You can also use the Burn 
Tool set to Range: Shadows 
to darken any parts that 
look messy.

02  ALTER THE HUE
It’s easy to change the 

colors in your shot using the 
Hue/Saturation commands. 
Click the Create Adjustment 
Layer icon in the Layers 
Panel and choose Hue/
Saturation. The settings 
will appear in the Properties 
panel – drag the Hue slider to 
the left or right to skew the 
colors. Experiment until you 
get something you like.

03  CHANGE COLORS
While you’re playing 

with Hue/Saturation, you 
can also target certain color 
ranges. Click the Master 
drop-down to choose a 
range or grab the Hand Tool 
from the settings, then 
hold Cmd/Ctrl and drag over 
colors. For more tweaks, 
try the Selective Color 
Adjustment Layer and see 
what you can achieve.

CHANGE COLORS IN PHOTOSHOP



ON SALE
NOW

DISCOVER SECRETS STRAIGHT FROM WORKING 
PROFESSIONAL PHOTOGRAPHERS
Learn from the informative features and follow the in-depth shooting and 
editing tutorials that will ensure you can produce high-quality professional 

looking captures. 

www.myfavouritemagazines.co.uk
Or get it from selected supermarkets & newsagents

Ordering is easy. Go online at:



If you’d like to watch the  
complete course now, get the 
app from the Apple App Store

This month, learn how to 
add custom watermarks to 
your images

LEARN LIGHTROOM TODAY!

LIKE THIS? NOW AVAILABLE ON 
THE APPLE APP STORE BIT.LY/TYLRAPP

BUY
NOW!

WATCH THE VIDEO
http://bit.ly/2qxx1aq





Your quick-start guide and reference  
to image editing in Photoshop

If you’re relatively new to editing in 
Photoshop, or you just don’t know 

where to begin, then this section is the best 
place to get started. Over the next 10 pages, 
you’ll find an overview of the different versions 
of Photoshop available; a breakdown of the 

typical image-editing workflow in Photoshop; 
an overview of raw file editing; a guide to the 
six most useful layers; and a glossary of the 
most useful shortcuts. This guide condenses 
most of the tools and techniques you’ll use 
every time you import a new roll of pictures.



CREATIVE CLOUD PLANS 
CHOOSE THE PLAN WITH THE COMBINATION OF TOOLS AND STORAGE YOU NEED

Photography Plan • 20GB Photography Plan • 1TB

Best for Traditional desktop users Cloud and desktop

Price per month £9.98/$9.99 £19.97/$19.99

Photoshop CC

Lightroom CC

Lightroom Classic

Lightroom Mobile

Cloud storage 20GB 1TB

Notes

If you want Photoshop, 
you need the regular 

Photography Plan – you 
also get Lightroom Classic

The same as the Photography 
Plan, but with 1TB storage. 
Existing users are offered 

a discount for the first year

Lightroom CC Plan Lightroom Mobile Premium

Best for Cloud fans Mobile-only users

Price per month £9.98/$9.99 £4.49/$6.49

Photoshop CC

Lightroom CC

Lightroom Classic

Lightroom Mobile

Cloud storage 1TB 100GB

Notes
With this plan you get the ‘new’ 
Lightroom CC and 1TB storage – 

but not Photoshop

This plan is for smart devices 
only. The Lightroom Mobile 

app is free, but the ‘premium’ 
version is an in-app purchase



Lightroom CC combines 
professional image-
processing tools with 

asset organizing. It keeps all its 
images online in the Creative 
Cloud, with advanced image 
search capabilities.

Lightroom Classic 
offers editing and 
organizing tools, but 

you can only store images on 
your computer.

LIGHTROOM CC
FROM £9.98/$9.99 PER MONTH  
WINDOWS, macOS

LIGHTROOM CLASSIC
FROM £9.98/$9.99 PER MONTH  
WINDOWS, macOS

Lightroom Mobile is 
the lightweight iPad, 
iPhone and Android 

version of the application, 
integrated with Lightroom 
CC. You can use Lightroom 
Mobile on its own for free, 
or use the Premium In-App 
Purchase to access the Adobe 
Creative Cloud. This enables 
you to create a collection 
of photos on your desktop 
copy of Lightroom, and sync 
them via the Creative Cloud 
to Lightroom Mobile on your 
portable devices. You can also 
get Lightroom Mobile via any 
Photography Plan.

LIGHTROOM MOBILE
FREE (PREMIUM: £4.49/$6.49 PER MONTH)
IPHONE, IPAD, ANDROID 

Photoshop is the software of choice for most professional 
and non-professional photographers. Beyond the standard 
photo-editing features, it boasts a vast array of more 

creative tools and filters. Layers are one of the key differences 
between Photoshop and Lightroom. They enable you to mask out 
selected parts to build up increasingly sophisticated images.

PHOTOSHOP CC 
FROM £9.98/$9.99 PER MONTH WINDOWS, macOS  

Elements is the consumer variant of Photoshop, and 
contains many of its key tools and features within a 
simplified interface. It’s limited, but it does provide access 

to layers for those who have switched to a Lightroom workflow.

ELEMENTS 15 £79.99/$99.99  WINDOWS, macOS



Adobe Shape enables 
you to turn photos and 
sketches into beautiful 

vector shapes for use in your 
designs or artwork. The app 
smooths out jagged edges in 
images, resulting in gorgeous 
vectors that are endlessly 
scalable, just as if you’d drawn 
them by hand with the Pen tool. 
Make a shape with the mobile 
app and the next time you open 
Photoshop on your desktop, the 
shape will sync to your Library. 
Drag it in to any document to 
add color and make further 
adjustments.

ADOBE SHAPE
FREE
IPHONE, IPAD, ANDROID 

Adobe Brush enables 
you to make your 
own custom brushes 

from photos or sketches for 
use in Photoshop, Illustrator 
or the Sketch app. The most 
successful subjects are usually 
those that can be easily 
isolated, such as a splash 
against white, or a leaf against 
the sky. You can capture objects 
for your brush tips using your 
device’s camera, choose from 
your camera roll, or use your 
Creative Cloud library. Once 
captured, you can then fine-
tune the look of the tip and 
apply brush settings.

ADOBE BRUSH
FREE
 IPHONE, IPAD, ANDROID 

Mix enables you to merge two photos together 
to create a composite image. It offers a simplified 
compositing process that makes it easy for beginners 

to start combining an object from one image with a background 
from another. You can then send the composite to Photoshop 
for further edits. If you like, you can also use Mix to edit a single 
image. It offers a few simple tonal adjustments and more 
complex edits such as Content-Aware Fill.

If you ever need help 
selecting coordinated colors 
for your designs, try using 

Adobe Color. It enables you to create 
color themes from photos taken on 
your mobile device. This could be 
anything from a scene in your local 
park to a famous painting. So if you 
come across an inspirational scene, 
capture the colors and save them.

ADOBE PHOTOSHOP MIX
FREE IPAD, ANDROID

ADOBE COLOR
FREE IPHONE, IPAD, ANDROID 



As the name suggests, this app enables you to paint 
freehand using a selection of brushes, colors and other 
tools. However, Sketch is more than just a painting 

app. It also enables you to connect with like-minded creatives, 
so you can follow artists and see their work updating. Once 
you’re done sketching the image on your iPad, you can upload 
to the Sketch community or continue working on the image 
in Photoshop CC. You can also bring in brushes made with 
Adobe Brush, and for those who can’t paint, there’s an option 
to overlay images so you can trace over a photo. Sketch is 
compatible with Adobe’s pen and ruler hardware, Ink and Slide, 
but you can get great results with your finger.

Fix is a retouching app 
for altering portraits and 
fixing marks or blemishes 

in your photos. Intelligent facial 
recognition locks onto eyes, lips 
noses and chins, making it easy to 
tweak a smile, tuck in a jawline or 
enlarge eyes, should you wish.

ADOBE PHOTOSHOP SKETCH
FREE IPAD

PHOTOSHOP FIX
FREE  IPAD 

If you’re a designer 
who wants to build 
a quick layout for a 

web or print page, then Comp is 
the ideal place to start piecing 
ideas, images and text together. 
You can draw common design 
elements such as text or image 
boxes with quick gestures. For 
example, a couple of squiggly 
lines with a dot makes a 
header, and a cross makes an 
image box. It makes it easy to 
mock up a layout in seconds. 
You can then add words and 
graphics. The app even spits 
out a Photoshop, Illustrator or 
InDesign document.

ADOBE COMP CC
FREE IPAD

Behance is the online 
social space for 
creatives to share 

and showcase their portfolios, 
connect with one another, 
and find work. With work 
from the best photographers, 
digital artists and designers 
out there, it’s also a great 
place to find inspiration for 
a new project. If you’re a 
Creative Cloud subscriber you 
can set up a Behance page in 
minutes. The Behance app 
for iOS devices enables you to 
manage your page, while the 
Creative Portfolio app provides 
a polished portfolio.

BEHANCE 
CREATIVE PORTFOLIO
FREE IPAD, IPHONE
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The image-editing process begins as 
soon as you’ve transferred your photos 

from your memory card to your computer.
The first stage is to begin sifting 

through your pictures to discover which are 
the keepers. The image organizer that comes 
with Photoshop is ideal for this task. Adobe 
Bridge has controls for keywording, rating and 
filtering your images, and there are handy tools 
for batch renaming files, creating panoramic 
stitches, making contact sheets and more.
        Launch Adobe Bridge and navigate to a 
folder containing new images. Use the cursor 
keys to quickly flick through the images and 
click below a thumbnail to add a star rating, or 
use the keyboard shortcut Cmd/Ctrl+1-5. You 
can then filter your images by the star rating to 
group the ones you want to work on.

   The next step is to open the images 
from Bridge into Adobe Camera Raw. ACR 
is the best place to make initial changes to 
your images to boost tones and correct any 
problems with exposure and so on. It doesn’t 
enable you to combine images – you’ll use 
Photoshop for that – but it does enable you to 
make the kind of edits photographers need.
      In Photoshop, you can further refine 
the image with layers and adjustment layers, 
which offer a much more flexible way of 
working than ACR. Once you’ve finished, it’s 
time to share it with a wider audience. Go to 
File>Save, and your image will be saved as a 
Photoshop document (PSD). This keeps all the 
layers intact, which means you can go back and 
retweak the image at a later date. However, 
PSD files are large and take up lots of hard drive 
space. If you want to share your images online 
or via email or social media, save them as JPEGs.

Manage your photos from capture to output in three stages

2

1

3



Discover how to process your raw files to perfection

The latest version of the raw file 
processor included with Photoshop is so 

powerful that most photos can be processed 
entirely in the raw processor, with no need for 
further editing in Photoshop. And by making 
your adjustments in Adobe Camera Raw 

rather than in Photoshop, you’ll ensure the 
best possible image quality, because raw files 
contain more picture information than bitmap 
images such as un-layered PSDs and JPEGs. 
Here’s our reference to the features you’ll use 
the most in the Basic panel.

THE BASIC 
PANEL IN ACR

TEMPERATURE
Use this slider to warm 
or cool an image if the 
White Balance tool fails to 
correct a color cast

CONTRAST 
Makes light pixels brighter 
and dark pixels darker

CLARITY
Controls the amount 
of midtone contrast

SATURATION
Controls the overall color 
intensity of the image

TINT 
This slider enables you to 
correct a green or magenta 
cast, again, if the White 
Balance tool fails

HIGHLIGHTS 
Controls the brightness 
of the lightest pixels

EXPOSURE 
Controls the overall 
brightness of the image

BLACKS 
Sets a point on the tonal 
range at which pixels 
should be pure black

SHADOWS
Controls the brightness 
of the darkest pixels

WHITES 
Sets a point on the tonal 
range at which pixels 
should be pure white

VIBRANCE
Adjusts the intensity of 
the less-saturated colors



The six most frequently used Photoshop layers for image 
editing, and how to use them to improve almost any photo

Photoshop has many types of layers 
and adjustment layers available, but 

there are six that you’ll find you need to use 
again and again. Learning how they should be 

used may seem a little daunting for beginners, 
but once you’ve got to grips with them, you’ll 
find they play a part in the creative process of 
almost every image you make.

02 CURVES
Curves is one of the most powerful 

adjustment layers. An S-shaped curve 
brightens the highlights and darkens the 
shadows, resulting in extra contrast. Create 
a Curves Adjustment Layer and click the 
middle of the diagonal line to add a central 
control point. Drag down on the lower part 
of the line and drag up on the upper part of 
the line to improve image contrast.

01 LEVELS
This should be the first layer you add 

to an image, because it fundamentally alters 
the tonal range of the entire image. Create 
a Levels Adjustment Layer, drag the Black 
Point slider inwards until it touches the left-
hand edge of the histogram, and drag the 
White Point slider inwards to the right-hand 
edge. This remaps the tones of the image to 
make more of the available tonal range.

03 HUE/SATURATION
This adjustment layer is best used 

for altering the intensity and brightness 
of individual color channels in an image – 
greens and blues in landscapes, for instance. 
Create a Hue/Saturation Adjustment Layer, 
click the Master menu and choose the color 
channel you’d like to adjust. Small changes 
are usually the most effective.



BEFOREAFTER

06 SELECTIVE SHARPENING
Once all other adjustments have 

been made, you need to sharpen the image 
for output. The traditional way is to create a 
merged layer at the top of the stack, apply 
Unsharp Mask, then paint on the mask to 
remove the sharpening from those parts 
of the image you want to remain soft. 
However, the Sharpen tool enables more 
control over the process by enabling you to 
build up the effect by brushing repeatedly 
with a low opacity brush. Create a new blank 
layer, select the Sharpen tool, tick Sample All 
Layers and set a Strength of 50% or lower.

05 DODGE AND BURN
One of the best ways to enhance a 

photo is by lightening or darkening selected 
areas of the image. This can be done with 
the Dodge and Burn tools, but rather than 
use them directly on the image, a separate 
grey layer gives you greater control. To 
create a Dodge and Burn layer, hold down 
Alt and click the Create a new layer icon in 
the Layers panel. Give the layer a name, 
then choose Mode: Overlay. Check Fill with 
Overlay-neutral color and click OK. Now use 
the Dodge and Burn tools (with Range set to 
Midtones) to work on the new layer.

04 HEALING LAYER
Most photos contain unwanted 

marks or blemishes. The Spot Healing Brush 
tool is effective at removing these. The best 
way to apply the healing is on a new blank 
layer, so that you can easily tone down or 
remove selected healing work later without 
having to start from scratch because you 
healed directly on the background layer. To 
do this, create a new blank layer, choose the 
Spot Healing Brush tool from the Tools panel 
and tick Sample All Layers on the Options 
Bar, then continue as normal.



D
Reset the foreground and background colors 
to black and white

ALT+[SCROLL WHEEL]
Zoom in or out of the image

[ OR ]
Resize the brush tip

CMD/CTRL+SHIFT+ALT+E
Create a merged copy of all the layers in the 
layer stack

SHIFT+[ OR ]
Cycle backwards or forwards through the 
layer blend modes

SPACE BAR
Temporarily switch the current tool to the Hand 
tool, for moving around the image while zoomed in

CMD/CTRL+[LAYER MASK]
Load the currently active layer mask as 
a new selection

ALT+[EYE ICON]
Switch off the visibility of all other layers in the 
layer stack, for before-and-after comparisons

CMD/CTRL+T
Activate the Free Transform tool

CMD/CTRL+I
Invert the color of a layer mask to black

SHIFT+[LAYER MASK]
Disable the effects of a layer mask

CMD/CTRL+J
Duplicate the current layer

X
Switch the foreground and background 
color swatches

14 keyboard shortcuts that will massively improve your 
speed and efficiency while working in Photoshop

CMD/CTRL+Z
Undo the last change made to the document. 
Works multiple times



Transform treasured memories 
into memorable wall art.

Mounted under acrylic, framed, or as large-format photo prints. Made in Germany
by people who love photography. We are the proud recipients of over 100 awards
and recommendations! Simply upload your photo and create custom works of art –
even from your smartphone.

‘ Best Photo Lab Worldwide ’
Awarded by the Editors of 29 International Photography Magazines

Repeat Winner of the TIPA Award – 2013/2017

WhiteWall.co.uk
Stores in London | Berlin | New York | Paris | Vienna | Zurich
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